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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published August 2023. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is 
provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction 
or distribution of the program or any portion thereof could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  

 

  



 

Cumulative Update 01 Release Notes iii 

 

Contents 
Overview ....................................................................................................................................................... 1 
Cobra 8.5 Cumulative Update 01 .................................................................................................................. 2 
Appendix A: Download and Install the Cumulative Update .......................................................................... 8 
Appendix B: For Additional Information ...................................................................................................... 12 
 

 



Overview 

Cumulative Update 01 Release Notes 1 

 

Overview 
This guide includes all of the enhancements, software issues resolved, and database changes that were 
made in the Cobra 8.5 Cumulative Update 01 release.  

Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before 
applying this update, consider whether you have any custom programs or reports in the application area 
affected by the update. If so, contact a Deltek Customer Success analyst at http://support.deltek.com 
before you install the update. 

 

Viewing the Online Help 
The Deltek Cobra Help System provides help for all areas of the Cobra application. 

 To access all documents available for Cobra 8.5, click 
https://help.deltek.com/Product/Cobra/8.5/GA. 

 To access the printable version of the Cobra Help System, see Cobra Help System in Portable 
Document Format. Take note that some of the links in the PDF version may not work. 

 To view the collection of videos that will help you work with Cobra, see Cobra Videos. 

 

Software Requirements (Compatibility Matrix) 
To see the list of the supported and compatible technologies, see “System Requirements” in the Deltek 
Cobra 8.5 Installation Guide. For a complete list of the recommended minimum software requirements, 
see the Deltek Product Support Compatibility Matrix document, which you can download from the Deltek 
Support Center site. 

Attention: For steps to install the cumulative update, see “Appendix A: Download and Install the 
Cumulative Update” in this document. 

Attention: You can access the online help using Microsoft Edge, Chrome, or Firefox. 

http://support.deltek.com/
https://help.deltek.com/Product/Cobra/8.5/GA
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=19D7D1D0-0FA5-4FDF-9154-977EFA38DC5B
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=19D7D1D0-0FA5-4FDF-9154-977EFA38DC5B
https://help.deltek.com/Product/Cobra/8.5/GA/Cobra%20Videos%20and%20Learning%20Aids.html
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=A0560884-2E02-497B-8B3D-72523AE141DA
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=A0560884-2E02-497B-8B3D-72523AE141DA
https://support.deltek.com/
https://support.deltek.com/
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Cobra 8.5 Cumulative Update 01 
Released: August 4, 2023 

Enhancements 
There are no enhancements in this release. 

Software Issues Resolved 
This section includes software issues resolved in this release.  

Batch Reports 

Defect 1930082  

Description: When you generated a batch report and then cancelled it, the currently running batch report 
continued to be generated while the succeeding batch reports were cancelled and not generated. 

Customers Impacted: All Cobra customers generating batch reports. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.ReportLayoutEngine.dll 

File » Integration Cost Data Export 

Defect 1670860  

Description: When you ran the Cost Data Export or wInsight Export process through the API and 
specified a value with illegal path characters in the ExportFile setting, Cobra failed to inform you that the 
process did not run because of an invalid parameter value. 

Customers Impacted: All Cobra customers using the Cost Data Export or wInsight Export process 
through the API. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

 Cobra.Toolkit.dll 
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File » Integration wInsight 

Defect 1670864  

Description: When you ran the wInsight Wizard, specified a value with illegal path characters in the 
Export file field on the Save and Run page, and clicked the Finish button, Cobra encountered the 
following error: "Unhandled Exception: Illegal characters in path." 

Customers Impacted: All Cobra customers using the wInsight Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

 Cobra.Toolkit.dll 

Defect 1961797  

Description: When you ran the wInsight Wizard, the saved value for the Code on resource field from the 
configuration file was not correctly displayed on the Element of Cost page.  

Customers Impacted: All Cobra customers using the wInsight Wizard.  

Workaround Before Fix: None.  

Additional Notes: This defect has been fixed in Cobra 8.4 Cumulative Update 24 (Defect 1859942). 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Resources.dll 

 Cobra.WinUI.Processes.dll 

File » Integration Wizard - Project Data 

Defect 1961801  

Description: When you ran the Integration Wizard and selected the List deleted items in the process 
log option on the Change Control page, the process log displayed the internal IDs of the deleted items 
instead of the actual control account (CA) and work package (WP) IDs.  

Customer Impacted: All Cobra customers using the Integration Wizard.  

Workaround Before Fix: None.  

Additional Notes: This defect has been fixed in Cobra 8.4 Cumulative Update 24 (Defect 1914553). 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Process.dll 
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Defect 1961794  

Description: When you tried to load codes using the Integration Wizard against a control account or work 
package and the import file contained a comma in the code value, Cobra did not correctly import the code 
containing the comma.  

Customers Impacted: All Cobra customers.  

Workaround Before Fix: Remove the comma in the work package name or value.  

Additional Notes: This defect has been fixed in Cobra 8.4 Cumulative Update 24 (Defect 1912287).  

Files Updated: 

 Cobra.Process.dll 

File » Restore 

Defect 1952757  

Description: When you restored a legacy backup file located in a different directory from the last restored 
legacy backup file, the Browse for Folder dialog box for the converted BK file did not default to the same 
directory as the legacy backup file being restored.  

Customers Impacted: All Cobra customers using the Restore process.  

Workaround Before Fix: None.  

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

Project Processes » Calculate Forecast 

Defect 1961795  

Description: When you ran the Calculate Forecast Wizard with a forecast class that used the Coded 
Ranges forecast method with future periods mapped to a Manual Forecast (Retain EAC) forecast 
method, Cobra deleted the resources instead of retaining the future periods. 

Customers Impacted: All Cobra customers using the Manual Forecast (Retain EAC) with Coded Ranges 
method. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.4 Cumulative Update 24 (Defect 1632595).  

Files Updated: 

 Cobra.Process.dll 

Defect 1961800  

Description: When you updated the forecast finish date and did not respread the forecast time-phased 
periods and then ran the Calculate Forecast Wizard, Cobra did not correctly include the last time-phased 
spread period if both the original and new finish dates were within the same fiscal period. 

Customers Impacted: All Cobra customers using the Calculate Forecast Wizard after updating the 
forecast finish date. 



Cobra 8.5 Cumulative Update 01 

Cumulative Update 01 Release Notes 5 

 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.4 Cumulative Update 24 (Defect 1825316). 

Files Updated: 

 Cobra.Process.dll 

Project Processes » Replan 

Defect 1955278  

Description: When you ran the Replan Wizard and the first class being processed was a control account 
(CA)-level budget class that was part of the budget, Cobra encountered the following error: "There is not 
enough memory to complete this operation." 

Customers Impacted: All Cobra customers running the Replan process on a CA-level budget class. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll  

Tools » Zero-out Data 

Defect 1957073  

Description: When you ran the Zero-Out Data Wizard and specified a date range on the Date Range 
page, Cobra did not use the period's start date specified in the From field.  

Customers Impacted: All Cobra customers using the Zero-Out Data Wizard. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.4 Cumulative Update 24 (Defect 1494107). 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  

 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Defect 1976126  

Description: When you ran the Zero-Out Data Wizard, some values that fell within the selected date 
range were not zeroed out. 

Customers Impacted: This defect affects customers who use the Zero-Out Data Wizard. 

Workaround Before Fix: None. 

Additional Notes: This defect has been fixed in Cobra 8.4 Cumulative Update 24 (Defect 1273430). 

Files Updated: 

 Cobra.WinUI.*.dll  

 Cobra.WinUI.exe  
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 Cobra.Model.dll  

 Cobra.Model.LoginManager.dll 

Security Enhancements 
There are no security enhancements in this release. 

Database Changes 
There are no database changes in this release. 

Data Changes 
There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation that are in addition to any 
enhancements. 

Document Details 

Deltek Cobra 8.5 
Help System 

 Updated the notes in the Exported Cost Data File topic 

 Updated the topic for the Project View tabs to display the Project View 
topic regardless of the selected tab 

 Updated the Reclass by a specific date range description in the Date 
Range Page of the Reclass Wizard topic 

 Updated the Recalc costs in a specific date range description in the 
Date Range Page of the Recalc Wizard topic 

 Updated the Zero-out values in a specific date range description in the 
Date Range Page of the Zero Out Data Wizard topic 

 Updated the By a specific data range description in the Calculation 
Range Page of the Apportionment Calculation Wizard topic 

 Updated the following topics with references to using CSV format in an 
import file: 

 Data Formats 

 Data Import - Apportionment Definition 

 Data Import - Apportionment Mapping 

 File Format for Importing Apportionment Definition 

 Created the Cobra Videos topic to house all Cobra videos 

 Added related video to the following topics: 

 Add a Resource to a Resource File 

 Add Control Account Dialog Box 

 Add Work Package Dialog Box 

https://help.deltek.com/Product/Cobra/8.5/GA/Exported%20Cost%20Data%20File.html
https://help.deltek.com/Product/Cobra/8.5/GA/Project%20View.html
https://help.deltek.com/Product/Cobra/8.5/GA/Date%20Range%20Page%20of%20the%20Reclass%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Date%20Range%20Page%20of%20the%20Reclass%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Date%20Range%20Page%20of%20the%20Recalc%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Date%20Range%20Page%20of%20the%20Zero%20Out%20Data%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Calculation%20Range%20Page%20of%20the%20Apportionment%20Calculation%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Calculation%20Range%20Page%20of%20the%20Apportionment%20Calculation%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Data%20Formats.html
https://help.deltek.com/Product/Cobra/8.5/GA/Data%20Import%20Apportionment%20Definition.html
https://help.deltek.com/Product/Cobra/8.5/GA/Data%20Import%20Apportionment%20Mapping.html
https://help.deltek.com/Product/Cobra/8.5/GA/File%20Format%20for%20Importing%20Apportionment%20Definition.html
https://help.deltek.com/Product/Cobra/8.5/GA/Cobra%20Videos%20and%20Learning%20Aids.html
https://help.deltek.com/Product/Cobra/8.5/GA/Add%20a%20Resource%20to%20a%20Resource%20File.html
https://help.deltek.com/Product/Cobra/8.5/GA/Add%20Control%20Account%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.5/GA/Add%20Work%20Package%20Dialog%20Box.html
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Document Details 

 Add Resource Assignment Dialog Box 

 Assignment Import/Assignment Export 

 Calendar Selection Page of the Export Calendar to Open Plan Wizard 

 Calendar Export to Open Plan 

 Data Import from Open Plan 

 Data Import Using Scheduling Tools 

 Export and Import Time-Phased Resource Assignments 

 Prepare the Open Plan Schedule 

 Project Selection Page of the Assignment Import/Assignment Export 
Wizard 

 Project View 

 Resources 

 Resource View 

 Schedule Mapping Page of the Integration Wizard - Open Plan 

 
Note: Refer to the “Video” section of each topic. 

https://help.deltek.com/Product/Cobra/8.5/GA/Add%20Resource%20Assignment%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.5/GA/Assignment%20Export%20Import.html
https://help.deltek.com/Product/Cobra/8.5/GA/Calendar%20Selection%20Page%20of%20the%20Export%20Calendar%20to%20OP%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Calendar%20Export%20to%20Open%20Plan.html
https://help.deltek.com/Product/Cobra/8.5/GA/Importing%20Data%20from%20Open%20Plan.html
https://help.deltek.com/Product/Cobra/8.5/GA/Data%20Import%20Using%20Scheduling%20Tools.html
https://help.deltek.com/Product/Cobra/8.5/GA/Export%20and%20Import%20Time%20Phased%20Resource%20Assignments.html
https://help.deltek.com/Product/Cobra/8.5/GA/Prepare%20the%20Open%20Plan%20Schedule.html
https://help.deltek.com/Product/Cobra/8.5/GA/Project%20Selection%20Page%20of%20the%20Assignment%20Export%20Import%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Project%20Selection%20Page%20of%20the%20Assignment%20Export%20Import%20Wizard.html
https://help.deltek.com/Product/Cobra/8.5/GA/Project%20View.html
https://help.deltek.com/Product/Cobra/8.5/GA/Resources.html
https://help.deltek.com/Product/Cobra/8.5/GA/The%20Resource%20View.html
https://help.deltek.com/Product/Cobra/8.5/GA/Schedule%20Mapping%20Page%20of%20the%20Integration%20Wizard%20Open%20Plan.html
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Appendix A: Download and Install the 
Cumulative Update  
You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
cumulative updates, and sub-releases. You can access DSM through the Deltek Support Center or use 
Deltek Software Manager Lite to download Deltek products. 

Access DSM and Download the Cumulative Update 
Use these instructions to download the cumulative update from DSM. 

To download the cumulative update: 
1. Using your web browser, go to https://dsm.deltek.com.  

2. Enter your Deltek Support Center Username and Password, and click Login. 

3. When the Deltek Support Center page displays, click Product Downloads. 

4. On the Deltek Software Manager screen, click Launch Deltek Software Manager. 
5. Click Run Deltek Software Manager.  
6. Log in using your Deltek Support Center credentials. 

7. In the Deltek Software Manager dialog box, at the top right, click Settings. 

8. In the Settings dialog box, specify the folder where you want to download the Deltek products, 
and click OK. 

 
9. In the left pane, expand the Deltek product that you want to download, if it is not already 

expanded, and select Cumulative Update. 

10. In the table, select the checkbox that corresponds to the cumulative update that you want to 
download. 

The right pane displays a message stating that the product has been added to the download 
queue. 

 
11. Click Download at the bottom of the left pane to download the product to the folder that you 

selected. 

Install the Cumulative Update 
The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment. Use 
the instructions below that apply to your deployment scenario. 

Note: When you log on for the first time, DSM asks you to select a default folder where 
Deltek products are to be downloaded. You can change this folder anytime in the Settings 
dialog box. 

Note: To view the items in the download queue, click View Download Queue at the bottom 
of the left pane. 

https://dsm.deltek.com/


Appendix A: Download and Install the Cumulative Update 

Cumulative Update 01 Release Notes 9 

 

 

If You Use a Deployment Server 
Use these instructions if you are using Cobra on a client/server (deployment server) deployment. 

To install on the server: 
1. Launch the update on the server.  

 
2. The Welcome screen displays the current build, along with the new build being installed by the 

update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

3. Click Finish.  

4. Depending on the type of update, a reboot may be required, so if the option to reboot your 
computer is enabled, select it and click Finish.  

5. Launch the Deltek Cobra shortcut on client workstations to initiate the update. 

To install on a client workstation: 
1. Launch the Deltek Cobra shortcut.  

Cobra detects that an updated version is available and displays the prompt: Do you want to 
install the upgrade?  

2. Click Yes to start the installation or No to cancel the installation.  

When the installation is completed, the installation Wizard closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have an N-Tier Deployment 
Use these instructions if you are using Cobra on an n-tier deployment. 

To install on the server: 
1. Launch the update on the server.  

 
2. The Welcome screen displays the current build, along with the new build being installed by the 

update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

3. Click Finish. 

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 
close Cobra. Click Yes to start the installation or No to cancel the installation. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 
close Cobra. Click Yes to start the installation or No to cancel the installation. 
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4. Depending on the type of update, a reboot may be required, so if the option to reboot your 
computer is enabled, select it and click Finish. 

5. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update. 

To install on an n-tier client workstation: 
1. Launch the Deltek Cobra shortcut.  

Cobra detects that an updated version is available and displays the prompt: Do you want to 
install the upgrade?  

2. Click Yes to start the installation or No to cancel the installation.  

If you choose Yes, the installation Wizard copies the updated DeltekCobraWorkstation.exe file 
locally and automatically begins installing files. When the installation is completed, the installation 
Wizard closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have a Terminal Services/Citrix Deployment 
Use these instructions if you are using Cobra on a terminal services/Citrix deployment. 

To install on the deployment server: 
1. Launch the update on the server. 

 
2. The Welcome screen displays the current build, along with the new build being installed by the 

update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

3. Click Finish. 

4. Depending on the type of update, a reboot may be required, so if the option to reboot your 
computer is enabled, select it and click Finish. 

5. Log on as a Local Administrator on the Terminal Server/Application Server and install the update. 

To install on the Terminal Server/ Application Server (the server on which the Cobra client runs): 
1. Log on to the Terminal Server using an account that has Local Administrator privileges.  

When the setup launches, the installation program installs all necessary files and any registry 
updates and makes these changes available to all users who will subsequently log on to the 
Terminal Server session to run Cobra.  

2. Ensure that no instance of Cobra is running.  

3. Browse to the shared Cobra Workstation folder (usually located on the deployment server, as 
\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).  

4. Launch the DeltekCobraWorkstation.exe file to install the update.  

The Welcome screen displays, showing that the update is available.  

5. Click Next to start the installation.  

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 
close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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6. When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm 
that the update is installed, meaning that users can now launch Cobra via Terminal 
Services/Citrix sessions. 

If You Have a Standalone Deployment 
Use these instructions if you are using Cobra on a standalone deployment. 

To install on the workstation: 
1. Verify that Cobra is not running.  

2. Launch the update on the server.  

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

The installation Wizard installs all necessary files and displays the Update Complete form.  

4. Click Finish.  
5. Depending on the type of update, a reboot may be required, so if the option to reboot your 

computer is enabled, select it and click Finish. 

6. Launch the Deltek Cobra shortcut to log into Cobra. 

Confirm that the Cumulative Update Is Installed 
Use these instructions to check that the version number reflects the installed cumulative update. 

To confirm that the cumulative update is installed: 

1. Click  » Help » About Deltek Cobra. 
2. Check that the version number reflects the installation of the update. 
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Appendix B: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support website for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 
 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Deltek Customer Success analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Deltek Customer Success analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  
1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 
 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the website. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

 

http://www.deltek.com/
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